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General
File Structure

Seed File=Z:\Root Workspace Location\Configuration\Organization-Civi\NADOT Corporate Standards\Seed\Rdwy modelseed.dgn

Rdwy modelseed.dgn has 3 Models
Design, Drawing and Sheet

Design is used for 1:1 line graphics
Drawing is used for Annotation
Sheet is used for Printing

Levels

Use the Levels provided

When you need a level:

Use Draft Plan Labels for Text and Cells
Use Draft _Sheet for Line work

otherwise use the level designation shown

Cell Libraries
roadway.cel, sheets.cel and summary.cel
We are only creating the cells we need

LineStyles
We are only creating the linestyles we need

Text
There is no weight with True Type Fonts

Below are all 1:1 values
Title Text
ft=Arial, Bold, tx=0.020, Line Spacing 0.50

New Text
ft= Arial, Betek Italic, tx=0.015, Line Spacing 0.50

Existing Text
ft=Arial, tx=0.012, Line Spacing 0.50

Printing
Turn Off Data Fields and Save Settings so they do not print
If the file has color print to Monochrome

Sheets
If the sheet is not applicable - disregard
ex. Survey Control Sheet, but the Project was not Surveyed

Primary Tools

Turn Off Properties and Explorer

unless these tools are necessary for Plans Production
These tools are used with OpenRoads Designer

Quick Access Toolbar
Restore the Ribbon
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fs - Face Sheet

Seed File=Z:\Root Workspace Location\Configuration\Organization-CivilNADOT Corporate Standards\Seed\Rdwy modelseed.dgn
Set Active>Sheet Model Drawing Scale 1:1

Place Active Cell

Attach File: Z:\Root Workspace Location\Configuration\WorkSpaces\ADO T\WorkSets\dev\dgn\Plans\sheets.cel
Highlight RDWYFS

right-click Place Cell

X Scale: 1.0

Y Scale: 1.0

place at coordinate 0,0

Drop Element>Complex
We must more the star

Fill in single Data Field

Fill out Project Information

include township and range on the north arrow

Fill in County data at the bottom of the north arrow
move the star to State Map Project Location
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see Z:\Root Workspace Location\Configuration\WorkSpaces\ADO T\WorkSets\dev\
dgn\Plans\Plan Sheet Documentation\ProjectCoversheetBuilder.docx

Import Raster Image

Interactive>Yes

Level: Draft_ Plan_Labels
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1A - Construction Standards Index Sheet
Seed File=Z:\Root Workspace Location\Configuration\Organization-Civi\ADOT Corporate Standards\Seed\Rdwy modelseed.dgn
Set Active>Sheet Model Drawing Scale 1:1

Place Active Cell

Attach File: Z:\Root Workspace Location\Configuration\WorkSpaces\ADO T\WorkSets\dev\dgn\Plans\sheets.cel
Highlight 1A

right-click Place Cell

X Scale: 1.0

Y Scale: 1.0

place at coordinate 0,0

ADOT STANDARD DRAWINGS
CONSTRUCTION STANDARDS
EFFECTIVE DECEMBER 2017
SUBJECT SUBJECT

DATE STANDARD TITLE DATE STANDARD TITLE
5/12 C-01.10 SH 1 SYMBOL LEGEND 12117 C-10.54 SH 1 CONCRETE HALF BARRIER, 32" TYPE 'F' AT PIERS, CAST-IN-PLACE
5/12 C-01.10 SH2 SYMBOL LEGEND 12117 C-10.54 SH2 CONCRETE HALF BARRIER, 32" TYPE 'F' AT PIERS, PRECAST
5/12 C-01.10 SH3 SYMBOL LEGEND 12117 C-10.54 SH 3 CONCRETE HALF BARRIER, 32" TYPE 'F' AT PIERS, LAYOUT
5/12 C-01.10 SH4 SYMBOL LEGEND 12117 C-10.55 SH 1 CONCRETE HALF BARRIER, 42" TYPE 'F' AT PIERS, CAST-IN-PLACE
12117 C-01.30 SH 1 GENERAL ABBREVIATIONS 12117 C-10.55 SH 2 CONCRETE HALF BARRIER, 42" TYPE 'F' AT PIERS, PRECAST
5/12 C-01.30 SH2 GENERAL ABBREVIATIONS 12117 C-10.55 SH 3 CONCRETE HALF BARRIER, 42" TYPE 'F' AT PIERS, LAYOUT
5/12 C-01.30 SH3 GENERAL ABBREVIATIONS 12117 C-10.70 SH 1 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CAISSONS

12117 C-10.70 SH 2 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CAISSONS
5/12 C-02.10 SLOPES, RURAL DIVIDED HIGHWAYS 12117 C-10.70 SH 3 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CAISSONS
5/12 C-02.20 SLOPES, RURAL UNDIVIDED AND FRINGE-URBAN HIGHWAYS 12117 C-10.71 SH 1 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CURB & GUTTER
5/12 C-02.30 SLOPES, MISCELLANEOUS ROADWAYS 12117 C-10.71 SH2 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CURB & GUTTER

12117 C-10.72 SH 1 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH CAISSONS
5/12 C-03.10 SH 1 DITCHES, CHANNELS, DIKES AND BERMS, DITCHES AND CHANNELS 12117 C-10.72 SH2 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH CAISSONS
5/12 C-03.10 SH2 DITCHES, CHANNELS, DIKES AND BERMS, DIKES 12117 C-10.72 SH 3 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH CAISSONS
5/12 C-03.10 SH 3 DITCHES, CHANNELS, DIKES AND BERMS, DITCH DIKE 12117 C-10.73 SH 1 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH GUTTER
5/12 C-03.10 SH4 DITCHES, CHANNELS, DIKES AND BERMS, PIPE BERMS 12117 C-10.73 SH2 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH GUTTER
5/12 C-03.10 SH5 DITCHES, CHANNELS, DIKES AND BERMS, HEADWALL BERMS 12117 C-10.74 CONCRETE HALF-BARRIER TRANSITION, 42" TO 32" TYPE 'F'

12117 C-10.75 SH 1 CONCRETE HALF-BARRIER TRANSITION, TYPE 'F' TANGENT DEPARTURE TYPE 1
12117 C-04.10 SH 1 SPILLWAY, EMBANKMENT SINGLE INLET 12117 C-10.75 SH 2 CONCRETE HALF-BARRIER TRANSITION, TYPE 'F' TANGENT DEPARTURE TYPE 2
12117 C-04.10 SH2 SPILLWAY, EMBANKMENT DOUBLE INLET 12117 C-10.76 CONCRETE HALF-BARRIER TRANSITION, TYPE 'F' AT RADIUS, 32" TO 0"
12117 C-04.20 SH 1 DOWNDRAIN, EMBANKMENT SINGLE INLET 12117 c-10.77 CONCRETE BARRIER TRANSITION TO GUARDRAIL END TERMINAL LAYOUT WITH CURB
12117 C-04.20 SH2 DOWNDRAIN, EMBANKMENT DOUBLE INLET 12117 C-10.78 CONCRETE HALF-BARRIER TRANSITION, 32" TYPE 'F' LOW SPEED APPROACH
12117 C-04.30 SPILLWAY LENGTH TABLE 12117 C-10.79 CONCRETE HALF-BARRIER TRANSITION, 42" TYPE 'F' TANGENT DEPARTURE
12117 C-04.40 DOWNDRAIN LENGTH TABLE
5/12 C-04.50 DOWNDRAIN ENERGY DISSIPATOR 5/12 C-11.10 SH 1 ROADWAY CATTLE GUARD

5/12 C-11.10 SH2 ROADWAY CATTLE GUARD
5/12 C-05.10 CURB & GUTTER, CURB, GUTTER 5/12 C-11.10 SH3 ROADWAY CATTLE GUARD
5/12 C-05.12 SH 1 CURB & GUTTER TRANSITIONS 5/12 C-11.10 SH4 ROADWAY CATTLE GUARD
5/12 C-05.12 SH2 CURB & GUTTER TRANSITIONS 5/12 C-11.20 CATTLE GUARD, DRAINAGE
5/12 C-05.12 SH 3 CURB AND GUTTER TRANSITIONS
5/12 C-05.20 SH 1 CONCRETE DRIVEWAYS & SIDEWALKS, DRIVEWAYS 5/12 C-12.10 SH 1 FENCE, WOVEN WIRE
5/12 C-05.20 SH 2 CONCRETE DRIVEWAYS & SIDEWALKS, SIDEWALKS 5/12 C-12.10 SH2 FENCE, BARBED WIRE
5/12 C-05.30 SH 1 SIDEWALK RAMP, TYPE A 5/12 C-12.10 SH3 FENCE, TYPE 1 AND 2 GATES, FLOOD GATE
5/12 C-05.30 SH2 SIDEWALK RAMP, TYPE B 5/12 C-12.10 SH4 FENCE, FLOOD GATE INSTALLATION
5/12 C-05.30 SH 3 SIDEWALK RAMP, TYPE C 5/12 C-12.10 SH5 FENCE, MISCELLANEOUS DETAILS
5/12 C-05.30 SH 4 SIDEWALK RAMP, TYPE D 5/12 C-12.20 SH 1 FENCE, CHAIN LINK, TYPE 1
5/12 C-05.30 SH5 SIDEWALK RAMP, TYPE E 5/12 C-12.20 SH2 FENCE, CHAIN LINK, TYPE 2
5/12 C-05.30 SH 6 SIDEWALK RAMP, TYPE F 5/12 C-12.20 SH 3 FENCE, CHAIN LINK, GATES
5/12 C-05.30 SH7 SIDEWALK RAMP, DETECTABLE WARNING STRIP 5/12 C-12.30 SH 1 FENCE, CHAIN LINK CABLE BARRIER
5/12 C-05.40 MEDIAN PAVING AND NOSE TAPER 5/12 C-12.30 SH2 FENCE, CHAIN LINK CABLE BARRIER
5/12 C-05.50 CONCRETE BUS BAY 5/12 C-12.30 SH3 FENCE, CHAIN LINK CABLE BARRIER
5/12 C-06.10 SH 1 DRIVEWAY & TURNOUT LAYOUTS 5/12 C-13.10 SH 1 PIPE CULVERT INSTALLATION
5/12 C-06.10 SH2 DRIVEWAY & TURNOUT LAYOUTS 5/12 C-13.10 SH2 PIPE CULVERT INSTALLATION

5/12 C-13.15 TYPICAL PIPE INSTALLATION
5/12 C-07.01 SH 1 PCCP JOINTS 5/12 C-13.20 PIPE, REINFORCED CONCRETE END SECTION
5/12 C-07.01 SH2 PCCP JOINTS 5/12 C-13.25 PIPE, CORRUGATED METAL END SECTION
5/12 C-07.02 LOAD TRANSFER DOWEL ASSEMBLY 5/12 C-13.30 PIPE AND PIPE ARCH, CORRUGATED METAL, CONCRETE INVERT PAVING
5/12 C-07.03 SH 1 PCCP JOINT LOCATIONS, MAINLINE SKEWED JOINTS 5/12 C-13.55 PIPE, CATTLE-VEHICLE PASS, MITERED END TREATMENT
5/12 C-07.03 SH2 PCCP JOINT LOCATIONS, MAINLINE SKEWED JOINTS 5/12 C-13.60 SLOTTED DRAIN DETAILS
5/12 C-07.03 SH3 PCCP JOINT LOCATIONS, MAINLINE SKEWED JOINTS 5/12 C-13.65 SLOTTED DRAIN INSTALLATION DETAILS
5/12 C-07.03 SH4 PCCP JOINT LOCATIONS, MAINLINE SKEWED JOINTS 5/12 C-13.70 STORM DRAIN CONNECTION DETAILS
5/12 C-07.03 SH5 PCCP JOINT LOCATIONS, MAINLINE NON-SKEWED JOINTS 5/12 C-13.75 STORM DRAIN OUTLET BARRIER GATE
5/12 C-07.03 SH6 PCCP JOINT LOCATIONS, MAINLINE NON-SKEWED JOINTS 5/12 C-13.76 STORM DRAIN OUTLET AND STORM DRAIN PLUG
5/12 C-07.03 SH7 PCCP JOINT LOCATIONS, MAINLINE NON-SKEWED JOINTS 5/12 C-13.80 PIPE COLLAR DETAILS
5/12 C-07.03 SH8 PCCP JOINT LOCATIONS, MAINLINE NON-SKEWED JOINTS
5/12 C-07.04 SH 1 PCCP JOINT LOCATIONS, PARALLEL-TYPE ENTRANCE RAMP WITH AUXILIARY LANE 5/12 C-15.10 CATCH BASIN, TYPE 1
5/12 C-07.04 SH2 PCCP JOINT LOCATIONS, PARALLEL-TYPE EXIT RAMP WITH AUXILIARY LANE 5/12 C-15.20 SH 1 CATCH BASIN, TYPE 3
5/12 C-07.04 SH3 PCCP JOINT LOCATIONS, TAPER-TYPE ENTRANCE RAMP 5/12 C-15.20 SH 2 CATCH BASIN, TYPE 3
5/12 C-07.04 SH4 PCCP JOINT LOCATIONS, TAPER-TYPE EXIT RAMP 5/12 C-15.20 SH 3 CATCH BASIN, ACCESS FRAME AND COVER DETAILS
5/12 C-07.04 SH5 PCCP JOINT LOCATIONS, CROSSROAD AND RAMP TERMINI 5/12 C-15.30 CATCH BASIN, TYPE 4
5/12 C-07.06 TRENCH BACKFILL AND PAVEMENT REPLACEMENT 5/12 C-15.40 SH 1 CATCH BASIN, TYPE 5

5/12 C-15.40 SH 2 CATCH BASIN, TYPE 5
5/12 C-08.20 PAVED GORE AREA 5/12 C-15.50 CATCH BASIN, FRAME AND GRATE

5/12 C-15.70 SH 1 CATCH BASIN, MISCELLANEOUS DETAILS
12117 C-10.00 GUARDRAIL MEASUREMENT LIMITS 5/12 C-15.70 SH 2 CATCH BASIN, MISCELLANEOUS DETAILS
12117 C-10.01 GUARDRAIL INSTALLATION 5/12 C-15.75 CATCH BASIN, DROP INLET
12117 C-10.03 W-BEAM GUARDRAIL, MGS BLOCKED-OUT TIMBER POST 5/12 C-15.80 CATCH BASIN, FLUSH
12117 C-10.04 W-BEAM GUARDRAIL, MGS BLOCKED-OUT STEEL POST 5/12 C-15.81 CATCH BASIN, SIDE SLOPE
12117 C-10.05 SH 1 W-BEAM GUARDRAIL (MODIFIED) WITH FREEWAY CURB AND GUTTER 5/12 C-15.90 CATCH BASIN, MEDIAN DIKE, PRECAST
12117 C-10.05 SH 2 W-BEAM GUARDRAIL (MODIFIED) WITH FREEWAY CURB AND GUTTER 5/12 C-15.91 SH 1 FREEWAY CATCH BASIN DETAILS
12117 C-10.06 W-BEAM GUARDRAIL LONG-SPAN 5/12 C-15.91 SH2 FREEWAY CATCH BASIN DETAILS
12117 C-10.07 SH 1 W-BEAM GUARDRAIL, BOX CULVERT GUARDRAIL POST 5/12 C-15.92 SH 1 CATCH BASIN WITH TYPE 'F' CONCRETE HALF BARRIER
12117 C-10.07 SH2 W-BEAM GUARDRAIL, BOX CULVERT GUARDRAIL POST 5/12 C-15.92 SH2 CATCH BASIN WITH TYPE 'F' CONCRETE HALF BARRIER
12117 C-10.08 SH 1 W-BEAM GUARDRAIL, END ANCHOR
12117 C-10.08 SH2 W-BEAM GUARDRAIL, END ANCHOR 5/12 C-16.40 IRRIGATION SLEEVES
12117 C-10.09 GUARDRAIL POST ROCK INSTALLATION
12117 C-10.20 SH 1 GUARDRAIL END TERMINAL PAD LAYOUT FOR SOFTSTOP 5/12 C-17.10 RAIL BANK PROTECTION FOR DRAINAGEWAYS, TYPES 1,2 & 3
12117 C-10.20 SH 2 GUARDRAIL END TERMINAL PAD LAYOUT FOR SOFTSTOP 5/12 C-17.15 RAIL BANK PROTECTION AT ABUTMENTS, TYPES 4, 5 & 6
12117 C-10.21 SH 1 GUARDRAIL END TERMINAL PAD LAYOUT FOR MSKT 5/12 C-17.20 RAIL BANK PROTECTION FOR DRAINAGEWAYS, TYPES 7, 8 & 9
12117 C-10.21 SH2 GUARDRAIL END TERMINAL PAD LAYOUT FOR MSKT
2/18 C-10.22 SH 1 GUARDRAIL END TERMINAL PAD LAYOUT FOR MAX-TENSION 5/12 C-18.10 SH 1 MANHOLE, RISER DETAILS
2/18 C-10.22 SH2 GUARDRAIL END TERMINAL PAD LAYOUT FOR MAX-TENSION 5/12 C-18.10 SH2 MANHOLE, BASE DETAILS, NORMAL INSTALLATION
12117 C-10.30 SH 1 GUARDRAIL TRANSITION TO CONCRETE BARRIER, TIMBER POST 5/12 C-18.10 SH 3 MANHOLE, FRAME AND COVER DETAILS
12117 C-10.30 SH2 GUARDRAIL TRANSITION TO CONCRETE BARRIER, TIMBER POST
12117 C-10.31 SH 1 GUARDRAIL TRANSITION TO CONCRETE BARRIER, STEEL POST 5/12 C-19.10 SH 1 FORD, CONCRETE WALLS
12117 C-10.31 SH2 GUARDRAIL TRANSITION TO CONCRETE BARRIER, STEEL POST 5/12 C-19.10 SH2 FORD, TYPES 1 AND 2
12117 C-10.38 SH 1 GUARDRAIL TAPER G4 TO MGS W-BEAM WITH STAGGERED POST
12117 C-10.38 SH2 GUARDRAIL TAPER G4 TO MGS W-BEAM WITH OFFSET RAIL 5/12 c-21.10 SURVEY MONUMENT FRAME AND COVER
12117 C-10.40 CONCRETE MEDIAN BARRIER, 32" TYPE 'F', CAST-IN-PLACE 5/12 C-21.20 SURVEY MARKER
12117 C-10.41 CONCRETE MEDIAN BARRIER, 42" TYPE 'F', CAST-IN-PLACE
12117 C-10.44 SH 1 CONCRETE MEDIAN BARRIER, 42" TYPE 'F'WITH VARIABLE HEIGHT SIDES, H=0"TO 26"
12117 C-10.44 SH2 CONCRETE MEDIAN BARRIER, 42" TYPE 'F'WITH VARIABLE HEIGHT SIDES, H=0"TO 26" . ADOT STANDARD DRAWINGS
12117 C-10.45 SH 1 CONCRETE MEDIAN BARRIER, 42" TYPE 'F'WITH VARIABLE HEIGHT SIDES, H=26"TO 60" REVISION DATES and STANDARD NO.'s REVIEW
12117 C-10.45 SH 2 CONCRETE MEDIAN BARRIER, 42" TYPE 'F'WITH VARIABLE HEIGHT SIDES, H=26"TO 60"
12117 C-10.50 SH 1 CONCRETE HALF BARRIER, 32" TYPE 'F', CAST-IN-PLACE NAME DATE
12117 C-10.50 S CONCRETE HALF BARRIER, 32" TYPE 'F', PRECAST
12117 C-10.51 CONCRETE HALF BARRIER. 32" TYPE 'F"WITH SIDEWALK CONSTRUCTION STANDARDS JOHN DOE 05/18
12117 C-10.52 CONCRETE HALF BARRIER, 32" TYPE 'F' WITH GUTTER PROJECT NO. A oF
12117 C-10.53 CONCRETE HALF BARRIER, 42" TYPE 'F' WITH GUTTER 040 CN 190 F0107 01C

RECORD DRAWING| FEDERAL ID NO. REC. DWG. DATE OF
DATA 040-C(224)T
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ADOT STANDARD DRAWINGS
CONSTRUCTION STANDARDS
EFFECTIVE DECEMBER 2017
SUBJECT SUBJECT

DATE STANDARD TITLE DATE STANDARD TITLE
5/12 C-01.10 SH 1 SYMBOL LEGEND 12117 C-10.54 SH 1 CONCRETE HALF BARRIER, 32" TYPE 'F' AT PIERS, CAST-IN-PLACE
5/12 C-01.10 SH?2 SYMBOL LEGEND 12117 C-10.54 SH?2 CONCRETE HALF BARRIER, 32" TYPE 'F' AT PIERS, PRECAST
5/12 C-01.10 SH 3 SYMBOL LEGEND 12117 C-10.54 SH 3 CONCRETE HALF BARRIER, 32" TYPE 'F' AT PIERS, LAYOUT
5/12 C-01.10 SH 4 SYMBOL LEGEND 12117 C-10.55 SH 1 CONCRETE HALF BARRIER, 42" TYPE 'F' AT PIERS, CAST-IN-PLACE
12117 C-01.30 SH 1 GENERAL ABBREVIATIONS 12117 C-10.55 SH 2 CONCRETE HALF BARRIER, 42" TYPE 'F' AT PIERS, PRECAST
5/12 C-01.30 SH?2 GENERAL ABBREVIATIONS 12117 C-10.55 SH 3 CONCRETE HALF BARRIER, 42" TYPE 'F' AT PIERS, LAYOUT
5/12 C-01.30 SH 3 GENERAL ABBREVIATIONS 12117 C-10.70 SH 1 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CAISSONS

12117 C-10.70 SH?2 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CAISSONS
5/12 C-02.10 SLOPES, RURAL DIVIDED HIGHWAYS 12117 C-10.70 SH 3 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CAISSONS
5/12 C-02.20 SLOPES, RURAL UNDIVIDED AND FRINGE-URBAN HIGHWAYS 12117 C-10.71 SH 1 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CURB & GUTTER
5/12 C-02.30 SLOPES, MISCELLANEOUS ROADWAYS 12117 C-10.71 SH?2 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 32" TYPE 'F' WITH CURB & GUTTER

12117 C-10.72 SH 1 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH CAISSONS
5/12 C-03.10 SH 1 DITCHES, CHANNELS, DIKES AND BERMS, DITCHES AND CHANNELS 12117 C-10.72 SH?2 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH CAISSONS
5/12 C-03.10 SH 2 DITCHES, CHANNELS, DIKES AND BERMS, DIKES 12117 C-10.72 SH 3 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH CAISSONS
5/12 C-03.10 SH 3 DITCHES, CHANNELS, DIKES AND BERMS, DITCH DIKE 12117 C-10.73 SH 1 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH GUTTER
5/12 C-03.10 SH 4 DITCHES, CHANNELS, DIKES AND BERMS, PIPE BERMS 12117 C-10.73 SH?2 CONCRETE HALF-BARRIER TRANSITION TO VERTICAL, 42" TO 32" TYPE 'F' WITH GUTTER
5/12 C-03.10 SH5 DITCHES, CHANNELS, DIKES AND BERMS, HEADWALL BERMS 12117 C-10.74 CONCRETE HALF-BARRIER TRANSITION, 42" TO 32" TYPE 'F'

12117 C-10.75 SH 1 CONCRETE HALF-BARRIER TRANSITION, TYPE 'F' TANGENT DEPARTURE TYPE 1
12117 C-04.10 SH 1 SPILLWAY, EMBANKMENT SINGLE INLET 12117 C-10.75 SH?2 CONCRETE HALF-BARRIER TRANSITION, TYPE 'F' TANGENT DEPARTURE TYPE 2
12117 C-04.10 SH 2 SPILLWAY, EMBANKMENT DOUBLE INLET 12117 C-10.76 CONCRETE HALF-BARRIER TRANSITION, TYPE 'F' AT RADIUS, 32" TO 0"
12117 C-04.20 SH 1 DOWNDRAIN, EMBANKMENT SINGLE INLET 12117 C-10.77 CONCRETE BARRIER TRANSITION TO GUARDRAIL END TERMINAL LAYOUT WITH CURB
12117 C-04.20 SH 2 DOWNDRAIN, EMBANKMENT DOUBLE INLET 12117 C-10.78 CONCRETE HALF-BARRIER TRANSITION, 32" TYPE 'F' LOW SPEED APPROACH
12117 C-04.30 SPILLWAY LENGTH TABLE 12117 C-10.79 CONCRETE HALF-BARRIER TRANSITION, 42" TYPE 'F' TANGENT DEPARTURE
12117 C-04.40 DOWNDRAIN LENGTH TABLE
5/12 C-04.50 DOWNDRAIN ENERGY DISSIPATOR 5/12 C-11.10 SH 1 ROADWAY CATTLE GUARD

5/12 C-11.10 SH?2 ROADWAY CATTLE GUARD
5/12 C-05.10 CURB & GUTTER, CURB, GUTTER 5/12 C-11.10 SH 3 ROADWAY CATTLE GUARD
5/12 C-05.12 SH 1 CURB & GUTTER TRANSITIONS 5/12 C-11.10 SH 4 ROADWAY CATTLE GUARD
5/12 C-05.12 SH 2 CURB & GUTTER TRANSITIONS 5/12 C-11.20 CATTLE GUARD, DRAINAGE
5/12 C-05.12 SH 3 CURB AND GUTTER TRANSITIONS
5/12 C-05.20 SH 1 CONCRETE DRIVEWAYS & SIDEWALKS, DRIVEWAYS 5/12 C-12.10 SH 1 FENCE, WOVEN WIRE
5/12 C-05.20 SH 2 CONCRETE DRIVEWAYS & SIDEWALKS, SIDEWALKS 5/12 C-12.10 SH?2 FENCE, BARBED WIRE
5/12 C-05.30 SH 1 SIDEWALK RAMP, TYPE A 5/12 C-12.10 SH 3 FENCE, TYPE 1 AND 2 GATES, FLOOD GATE
5/12 C-05.30 SH 2 SIDEWALK RAMP, TYPE B 5/12 C-12.10 SH 4 FENCE, FLOOD GATE INSTALLATION
5/12 C-05.30 SH 3 SIDEWALK RAMP, TYPE C 5/12 C-12.10 SH5 FENCE, MISCELLANEOUS DETAILS
5/12 C-05.30 SH 4 SIDEWALK RAMP, TYPE D 5/12 C-12.20 SH 1 FENCE, CHAIN LINK, TYPE 1
5/12 C-05.30 SH5 SIDEWALK RAMP, TYPE E 5/12 C-12.20 SH?2 FENCE, CHAIN LINK, TYPE 2
5/12 C-05.30 SH 6 SIDEWALK RAMP, TYPE F 5/12 C-12.20 SH 3 FENCE, CHAIN LINK, GATES
5/12 C-05.30 SH7 SIDEWALK RAMP, DETECTABLE WARNING STRIP 5/12 C-12.30 SH 1 FENCE, CHAIN LINK CABLE BARRIER
5/12 C-05.40 MEDIAN PAVING AND NOSE TAPER 5/12 C-12.30 SH?2 FENCE, CHAIN LINK CABLE BARRIER
5/12 C-05.50 CONCRETE BUS BAY 5/12 C-12.30 SH 3 FENCE, CHAIN LINK CABLE BARRIER
5/12 C-06.10 SH 1 DRIVEWAY & TURNOUT LAYOUTS 5/12 C-13.10 SH 1 PIPE CULVERT INSTALLATION
5/12 C-06.10 SH 2 DRIVEWAY & TURNOUT LAYOUTS 5/12 C-13.10 SH?2 PIPE CULVERT INSTALLATION

5/12 C-13.15 TYPICAL PIPE INSTALLATION
5/12 C-07.01 SH 1 PCCP JOINTS 5/12 C-13.20 PIPE, REINFORCED CONCRETE END SECTION
5/12 C-07.01 SH?2 PCCP JOINTS 5/12 C-13.25 PIPE, CORRUGATED METAL END SECTION
5/12 C-07.02 LOAD TRANSFER DOWEL ASSEMBLY 5/12 C-13.30 PIPE AND PIPE ARCH, CORRUGATED METAL, CONCRETE INVERT PAVING
5/12 C-07.03 SH 1 PCCP JOINT LOCATIONS, MAINLINE SKEWED JOINTS 5/12 C-13.55 PIPE, CATTLE-VEHICLE PASS, MITERED END TREATMENT
5/12 C-07.03 SH?2 PCCP JOINT LOCATIONS, MAINLINE SKEWED JOINTS 5/12 C-13.60 SLOTTED DRAIN DETAILS
5/12 C-07.03 SH 3 PCCP JOINT LOCATIONS, MAINLINE SKEWED JOINTS 5/12 C-13.65 SLOTTED DRAIN INSTALLATION DETAILS
5/12 C-07.03 SH 4 PCCP JOINT LOCATIONS, MAINLINE SKEWED JOINTS 5/12 C-13.70 STORM DRAIN CONNECTION DETAILS
5/12 C-07.03 SH5 PCCP JOINT LOCATIONS, MAINLINE NON-SKEWED JOINTS 5/12 C-13.75 STORM DRAIN OUTLET BARRIER GATE
5/12 C-07.03 SH6 PCCP JOINT LOCATIONS, MAINLINE NON-SKEWED JOINTS 5/12 C-13.76 STORM DRAIN OUTLET AND STORM DRAIN PLUG
5/12 C-07.03 SH7 PCCP JOINT LOCATIONS, MAINLINE NON-SKEWED JOINTS 5/12 C-13.80 PIPE COLLAR DETAILS
5/12 C-07.03 SH 8 PCCP JOINT LOCATIONS, MAINLINE NON-SKEWED JOINTS
5/12 C-07.04 SH 1 PCCP JOINT LOCATIONS, PARALLEL-TYPE ENTRANCE RAMP WITH AUXILIARY LANE 5/12 C-15.10 CATCH BASIN, TYPE 1
5/12 C-07.04 SH?2 PCCP JOINT LOCATIONS, PARALLEL-TYPE EXIT RAMP WITH AUXILIARY LANE 5/12 C-15.20 SH 1 CATCH BASIN, TYPE 3
5/12 C-07.04 SH 3 PCCP JOINT LOCATIONS, TAPER-TYPE ENTRANCE RAMP 5/12 C-15.20 SH 2 CATCH BASIN, TYPE 3
5/12 C-07.04 SH 4 PCCP JOINT LOCATIONS, TAPER-TYPE EXIT RAMP 5/12 C-15.20 SH 3 CATCH BASIN, ACCESS FRAME AND COVER DETAILS
5/12 C-07.04 SH5 PCCP JOINT LOCATIONS, CROSSROAD AND RAMP TERMINI 5/12 C-15.30 CATCH BASIN, TYPE 4
5/12 C-07.06 TRENCH BACKFILL AND PAVEMENT REPLACEMENT 5/12 C-15.40 SH 1 CATCH BASIN, TYPE 5

5/12 C-15.40 SH?2 CATCH BASIN, TYPE 5
5/12 C-08.20 PAVED GORE AREA 5/12 C-15.50 CATCH BASIN, FRAME AND GRATE

5/12 C-15.70 SH 1 CATCH BASIN, MISCELLANEOUS DETAILS
12117 C-10.00 GUARDRAIL MEASUREMENT LIMITS 5/12 C-15.70 SH?2 CATCH BASIN, MISCELLANEOUS DETAILS
12117 C-10.01 GUARDRAIL INSTALLATION 5/12 C-15.75 CATCH BASIN, DROP INLET
12117 C-10.03 W-BEAM GUARDRAIL, MGS BLOCKED-OUT TIMBER POST 5/12 C-15.80 CATCH BASIN, FLUSH
12117 C-10.04 W-BEAM GUARDRAIL, MGS BLOCKED-OUT STEEL POST 5/12 C-15.81 CATCH BASIN, SIDE SLOPE
12117 C-10.05 SH 1 W-BEAM GUARDRAIL (MODIFIED) WITH FREEWAY CURB AND GUTTER 5/12 C-15.90 CATCH BASIN, MEDIAN DIKE, PRECAST
12117 C-10.05 SH 2 W-BEAM GUARDRAIL (MODIFIED) WITH FREEWAY CURB AND GUTTER 5/12 C-15.91 SH 1 FREEWAY CATCH BASIN DETAILS
12117 C-10.06 W-BEAM GUARDRAIL LONG-SPAN 5/12 C-15.91 SH?2 FREEWAY CATCH BASIN DETAILS
12117 C-10.07 SH 1 W-BEAM GUARDRAIL, BOX CULVERT GUARDRAIL POST 5/12 C-15.92 SH 1 CATCH BASIN WITH TYPE 'F' CONCRETE HALF BARRIER
12117 C-10.07 SH?2 W-BEAM GUARDRAIL, BOX CULVERT GUARDRAIL POST 5/12 C-15.92 SH?2 CATCH BASIN WITH TYPE 'F' CONCRETE HALF BARRIER
12117 C-10.08 SH 1 W-BEAM GUARDRAIL, END ANCHOR
12117 C-10.08 SH 2 W-BEAM GUARDRAIL, END ANCHOR 5/12 C-16.40 IRRIGATION SLEEVES
12117 C-10.09 GUARDRAIL POST ROCK INSTALLATION
12117 C-10.20 SH 1 GUARDRAIL END TERMINAL PAD LAYOUT FOR SOFTSTOP 5/12 C-17.10 RAIL BANK PROTECTION FOR DRAINAGEWAYS, TYPES 1,2 & 3
12117 C-10.20 SH 2 GUARDRAIL END TERMINAL PAD LAYOUT FOR SOFTSTOP 5/12 C-17.15 RAIL BANK PROTECTION AT ABUTMENTS, TYPES 4,5 & 6
12117 C-10.21 SH 1 GUARDRAIL END TERMINAL PAD LAYOUT FOR MSKT 5/12 C-17.20 RAIL BANK PROTECTION FOR DRAINAGEWAYS, TYPES 7,8 & 9
12117 C-10.21 SH?2 GUARDRAIL END TERMINAL PAD LAYOUT FOR MSKT
2/18 C-10.22 SH 1 GUARDRAIL END TERMINAL PAD LAYOUT FOR MAX-TENSION 5/12 C-18.10 SH 1 MANHOLE, RISER DETAILS
2/18 C-10.22 SH 2 GUARDRAIL END TERMINAL PAD LAYOUT FOR MAX-TENSION 5/12 C-18.10 SH?2 MANHOLE, BASE DETAILS, NORMAL INSTALLATION
12117 C-10.30 SH 1 GUARDRAIL TRANSITION TO CONCRETE BARRIER, TIMBER POST 5/12 C-18.10 SH 3 MANHOLE, FRAME AND COVER DETAILS
12117 C-10.30 SH 2 GUARDRAIL TRANSITION TO CONCRETE BARRIER, TIMBER POST
12117 C-10.31 SH 1 GUARDRAIL TRANSITION TO CONCRETE BARRIER, STEEL POST 5/12 C-19.10 SH 1 FORD, CONCRETE WALLS
12117 C-10.31 SH?2 GUARDRAIL TRANSITION TO CONCRETE BARRIER, STEEL POST 5/12 C-19.10 SH?2 FORD, TYPES 1 AND 2
12117 C-10.38 SH 1 GUARDRAIL TAPER G4 TO MGS W-BEAM WITH STAGGERED POST
12117 C-10.38 SH 2 GUARDRAIL TAPER G4 TO MGS W-BEAM WITH OFFSET RAIL 5/12 C-21.10 SURVEY MONUMENT FRAME AND COVER
12117 C-10.40 CONCRETE MEDIAN BARRIER, 32" TYPE 'F', CAST-IN-PLACE 5/12 C-21.20 SURVEY MARKER
12117 C-10.41 CONCRETE MEDIAN BARRIER, 42" TYPE 'F', CAST-IN-PLACE
12117 C-10.44 SH 1 CONCRETE MEDIAN BARRIER, 42" TYPE 'F'WITH VARIABLE HEIGHT SIDES, H=0"TO 26"
12117 C-10.44 SH?2 CONCRETE MEDIAN BARRIER, 42" TYPE 'F'WITH VARIABLE HEIGHT SIDES, H=0"TO 26" | ADOT STANDARD DRAWINGS
12117 C-10.45 SH 1 CONCRETE MEDIAN BARRIER, 42" TYPE 'F'WITH VARIABLE HEIGHT SIDES, H=26"TO 60" REVISION DATES and STANDARD NO.'s REVIEW
12117 C-10.45 SH 2 CONCRETE MEDIAN BARRIER, 42" TYPE 'F'WITH VARIABLE HEIGHT SIDES, H=26"TO 60"
12117 C-10.50 SH 1 CONCRETE HALF BARRIER, 32" TYPE 'F', CAST-IN-PLACE NAME DATE
12117 C-10.50 SH 2 CONCRETE HALF BARRIER, 32" TYPE 'F', PRECAST
1217 C-10.51 CONCRETE HALF BARRIER. 32" TYPE 'F'WITH SIDEWALK CONSTRUCTION STANDARDS JOHN DOE 05/18
12/17 C-10.52 CONCRETE HALF BARRIER, 32" TYPE 'F' WITH GUTTER PROJECT NO. A -
12117 C-10.53 CONCRETE HALF BARRIER, 42" TYPE 'F' WITH GUTTER 040 CN 190 E0107 01C O

RECORD DRAWING| FEDERAL ID NO. REC. DWG. DATE OF
DATA 040-C(224)T




bdr - Border File
Seed File=Z:\Root Workspace Location\Configuration\Organization-Civi\ADOT Corporate Standards\Seed\Rdwy modelseed.dgn
Set Active>Sheet Model Drawing Scale 1:1

Place Active Cell

Attach File: Z:\Root Workspace Location\Configuration\WorkSpaces\ADO T\WorkSets\dev\dgn\Plans\sheets.cel
Highlight RDWYPL

right-click Place Cell

X Scale: 1.0

Y Scale: 1.0

place at coordinate 0,0

Fill in single Data Field
Fill out Project Information
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NAME DATE ARIZONA DEPARTMENT OF TRANSPORTATION STATE PROJECT NO. FEDERAL IDNO, | SHEET | TOTAL | pecORD DRAWING
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DRAWN ROADWAY DESIGN SECTION ARIZ.| 040 CN 190 040-C(224)T
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ds1 - Design Sheet #1
Seed File=Z:\Root Workspace Location\Configuration\Organization-Civi\ADOT Corporate Standards\Seed\Rdwy modelseed.dgn

Drawing Model Drawing Scale 1":10'
Sheet Model Drawing Scale 1":10'

Draw the Typical Section in the Design Model 1:1
View>Create Saved View>Name: 1 Description: TYP>Select the View

element description: Line element description: Line
level: TC Dirt level: TC Asphalt

color: BylLevel (70) c.olor: BylLevel (8)

line style: BylLevel (0) line style: BylLevel (0)
weight: BylLevel (0) weight: BylLevel (3)

element description: Line
level: TC Asphalt

color: BylLevel (8)

line style: BylLevel (0)
weight: Bylevel (3)

\ element description: Line

level: TC _Aggregate
color: BylLevel (64)
line style: ByLevel (0)
weight: BylLevel (3)

element description: Line

level: TC Dirt element description: Line
color: BylLevel (70) level: TC Dirt

line style: BylLevel (0) color: BylLevel (70)
weight: BylLevel (0) line style: BylLevel (0)

weight: BylLevel (0)

Attach Reference file: Border (Sheet) into the Sheet Model 1":10">Drawing Boundary - none

Attach Reference file: f0107ds1.dgn Design Model by Saved View (TYP) for the Typical Section LineWork>Drawing Boundary - none
Dimension Style and Text Style for Typical Section Annotation

see Z:\Root Workspace Location\Configuratiom\WorkSpaces\ADO T\WorkSets\dev\dgn\Plans\Text\DimensionStyles.docx

Title Text Font: Arial Bold tx=0.020 Line Spacing=0.50
New Text Font: Arial Italic tx=0.015  Line Spacing=0.50
Existing Text Font: Arial tx=0.012  Line Spacing=0.50

Seperate Dimension Text first by a value of 6 (from the element) and every 4 after
Place Cells from Attach File: Z:\Root Workspace Location\Configuration\WorkSpaces\ADO T\WorkSets\dev\dgn\Plans\roadway.cel
Earthwork Table Formatting, see P-STD 08>scale 100.00
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REFERENCES MIDPOINT OF PROJECT DESIGN DATA LENGTH OF PROJECT

1 40-3(22) Central Zone 20 AADT = 23,105 Sta  6+59.00to  9+88.00 = 329. 00', .
| 40-3(29) State Plane Coordinates 20 AADT = 25,609 Gross and Net Length = 329.00"- 0.1 Miles
X=752,400 Design Speed = 40 MPH
Y=1,527,900
INDEX OF SHEETS
Sheet No. Sheet Type
1 Face Sheet
1A-1D ADOT Standard Drawings
2 Design Sheet
3 Summary Sheet
4 Detail Sheet
5 Survey Control Sheet
1-40 1-40 6 Geometric Sheet
7 Plan Sheet
Eastbound Westbound :
CL CL 8-13 Plan and Profile Sheets
12’ 12’ 12’ 12’
10’ 4 4 | 100
95 | | 995 95 | 9.5
— ‘_‘ 6" | NG ’_'
57’ 57'

GENERAL NOTES

| The roadway plans have been designed utilizing
the 2012 Construction Standard Drawings (C-Series) |
| . and current revisions. Refer to the 1A sheet for a
listing of current revision dates. |
; R/W markers will be furnished and placed by
ADOT R/W Plans Section forces. |

EARTHWORK CALCULATION

FINAL CALCULATIONS
Exc(+) Emb(-)

Roadway Excavation (thru 10% Shrnk) 590 CY

Shrink 59 CY
Roadway Excavation (thru 25% Swell) 2473

Swell 302 CY

* Railbank Excavation 152 CY
Shrink 15 CY

* Gabion Basket Excavation 602 CY
Shrink 60 CY

* Spillway 10 CY
Shrink 1 CY
Structure Excavation 190 CY CY
Shrink 19 CY
* Railbank Backfill 364 CY
* Gabion Basket Backfill 371 CY
Structure Backfill 0 CY
Embankment (Inc GC) 2062 CY
Waste 1368 CY
4319 CY 4319 CY

NAME DATE ARIZONA DEPARTMENT OF TRANSPORTATION STATE PROJECT NO. FEDERAL IDNO. | SHEET [ TOTAL | prcoRD DRAWING
DESIGN INFRASTRUCTURE DELIVERY AND OPERATIONS DIVISION F HW.A. Arizona Division NO. |SHEETS
DRAWN ROADWAY DESIGN SECTION ARIZ.| 040 CN 190 040-C(224)T
CHECKED ROUTE LOCATION
TEAM LEADER [-40 A-1 MOUNTAIN TI UP STR. NO. 896
MADOT
SHEET OF TRACS NO. F0107 01C Infrastructure Delivery and Operations - OF_




sb1 - Summary Sheet
Seed File=Z:\Root Workspace Location\Configuration\Organization-Civi\ADOT Corporate Standards\Seed\Rdwy modelseed.dgn
Set Active>Sheet Model Drawing Scale 1:1

Attach Reference file: Border into the Sheet Model 1:1 Open the excel file: f0107BSumRuralF.xIsx o .
1. Select the Area in the Excel file to be placed in MicroStation
Place Active Cell 2. Copy

Attach File: Z:\Root Workspace Location\Configuration\WorkSpaces\ADOT\WorkSets\dev\dgn\Plans\summary.cel 3. In MicroStation, Right click in the View for the pop-up menu
Highlight BSUMRURALF 4. Select>Paste from Clipboard
right-click Place Cell 5. Select>Paste as: Embedded

X Scale: 1.0 Select>Method: By Corner
Y Scale: 1.0 Extended Setting>Select>Transparent Background and Rotate With View
place at coordinate 0,0 6. Pick the two corners for the Paste

/. Move as necessary

EB 1630+05 RT Begin 1 X 1
1] x| x 187.5 1125
EB1632+77 RT End 1
EB 1651+55 RT Begin 1 X 1
2 | x| x 1875 125
EB 1654+27 RT End 1
EB1694+00 LT Begin 1 X 1
3 | x| x 350.0 4500
EB 1698+00 LT End 1 X 1
___________________________________________________________________________________________________________________________ EB 1695+00 RT Begin 1 X 1
nl 4 | x| x 775.0 9875
EB 1703+25 RT End 1 X 1
DIVIDED ROADWAY WITH WB 169705 RT Begin !
ONE-WAY ROADWAY TWO-WAY ROADWAY WITH STRUCTURE © HIGH TENSION MEDIAN CABLE BARRIER ——— 5 [ x| x 262.5 4625 — ; 1
Begin Station -\ /- End Station Begin Station End Station Begin Station End Station Begin Sia= LON Point =y = EndSia= LON Foit
iz
e ¢ - . % . - | Sl ' Diectionof h n n GAMA) 6 | x| x 375.0 9 4875 Begn ! X !
"] Stationing Stationing
S — EB1718+45LT End 1 X 1
Begin Station -/ \- End Station Begin Station £nd Station Begin Station End Station Begin Sta =LON Point ' == End Sta = LON Point
EB1716+15RT Begin 1 X 1
1 END TREATMENT | 7| x| x 262.5 9 3625
EB1719+28 LT End 1 X 1
LOCATION BARRIER TRANSITION EXISTING
NEW GUARDRAIL ’ EXISTING GUARDRAIL ’ CONCRETE BARRIER Action WB1716+20 LT s | x| x 3375 9 3875 Begin 1
WB 1720+26 LT End 1 x |1
WB1717+31RT Begin 1
9 | x| x 3125 9 2625
WB1721+12 LT End 1 x |1
EB 1744+06 RT Begin 1 X 1
10 [ x| x 187.5 1125
EB1746+78 RT End 1
EB1798+00 LT Begin 1 X 1 7 BOLTED POSTS TO HEADWALL
1 x| x 325.0 350.0
EB1801+75LT End 1 X 1 | Do NOTAPPLY 2 OFFSET
EB 1799+25 RT Begin 1 X 1 |7 BOLTED POSTSTO HEADWALL
REMARKS I 12 | x| x 300.0 2750
EB 1802+75 RT End 1 X 1 DO NOT APPLY 2' OFFSET
IEZE N ET | | | [ 20 | | | [ [ T el [Tl Jef fof [ 1] [s] [of [ [ [o]

Print Monochrome

REV. DATE: 03/06/2018

Pick Corners Here

THE ZEROS IN PARENTHESES (0.0) INDICATE THE NOTE: FOR RECORD DRAWING PREPARATION - CIRCLE END z ALLOWABLE END TREATMENT OPTIONS ARE INDICATED WITH
DIMENSIONAL PRECISION FOR THAT COLUMN. TREATMENT INSTALLED. THE NUMBER '1' IN THE SPACE. BLANK SPACES ARE NOT
VIABLE ALTERNATIVES.
LENGTH IS FROM LENGTH OF NEED (LON) POINT TO LON 0 SEE BRIDGE SHEETS FOR BRIDGE BARRIER DETAILS AND
POINT. ACTUAL SEGMENT LENGTH VARIES DEPENDING QUANTITIES. D ARRAY TYPE AND ANGLE IS NOTED UNDER 'REMARKS'.
ON TERMINAL TYPE. SEE SPECIAL PROVISIONS.
e DATE xﬂ !BN! B!ME MEH ”I.- Eﬂgﬂﬂﬂ ﬂ 8! STATE T T‘%ET -STHETérLS RECORD DRAWING

DESIGN INFRASTRUCTURE DELIVERY AND OPERATIONS DIVISION F.H.W.A. Arizona Division

DRAWN ROADWAY DESIGN SECTION ARIZ.

CHECKED — ST

TEAM LEADER |

TRACS NO. | ADOT | OF.
SHET OF Infrastructure Delivery and Operatian — —

P-STD 05



DIVIDED ROADWAY WITH

TWO-WAY ROADWAY WITH STRUCTURE @ HIGH TENSION MEDIAN CABLE BARRIER

ONE-WAY ROADWAY

REV. DATE: 03/06/2018

Begin Station : : End Station Begin Station : End Station 7 K Begin Station : End Station Begin Sta = LON Point -\ Y End Sta = LON Point
Direction of | | =2 | | Direction of | | = '=|' | | Direction of & :} = 5 =5 —5 '/I ol
Stationing ' <= ' Stationing ' = ' Stationing e o o o ——— oo
VR : / = AN
Begin Station End Station Begin Station End Station X Z Begin Station End Station Begin Sta = LON Point - N— End Sta = LON Point
END TREATMENT
LOCATION BARRIER TRANSITION NEW EXISTING
NEW GUARDRAIL / EXISTING GUARDRAIL /  CONCRETE BARRIER / CABLE CONC Each (4 Action / Each 4 /
RAIL BARRIER/S7ES

~\
T
3)
N o
N K
N
&/~
O/0
2/ &
</ o *~
SIS &/ >/ &
S/@ S/5/8/S/&/8/O
3/ T/G/E S/ </ @ REMARKS
EB 1630+05 RT X 1
1 X | X 187.5 1125
EB 1632+77 RT
EB 1651+55 RT Begin 1 X 1
2 X | X 187.5 1125
EB 1654+27 RT End 1
EB 1694+00 LT Begin 1 X 1
3 X | X 350.0 450.0
EB 1698+00 LT End 1 X 1
EB 1695+00 RT Begin 1 X 1
4 X | X 775.0 987.5
EB 1703+25 RT End 1 X 1
WB 1697+05 RT Begin 1
5 X | X 262 .5 462.5
WB 1700+36 RT End 1 X 1
EB1714+20 LT Begin 1 X 1
6 X1 X 375.0 9 487.5
EB1718+45 LT End 1 X 1
EB1716+15RT Begin 1 X 1
7 X | X 262.5 9 362.5
EB1719+28 LT End 1 X 1
WB1716+20 LT Begin 1
8 X | X 337.5 9 387.5
WB 1720+26 LT End 1 X 1
WB 1717+31 RT Begin 1
9 X1 X 312.5 9 262.5
WB1721+12 LT End 1 X 1
EB 1744+06 RT Begin 1 X 1
10 X | X 187.5 1125
EB 1746+78 RT End 1
EB 1798+00 LT Begin 1 X 1 7 BOLTED POSTS TO HEADWALL
11 X | X 325.0 350.0
EB1801+75LT End 1 X 1 | DO NOT APPLY 2' OFFSET
EB 1799+25 RT Begin 1 X 1 |7 BOLTED POSTS TO HEADWALL
12 X1 X 300.0 275.0
EB 1802+75 RT End 1 X 1 DO NOT APPLY 2' OFFSET
3862.5 36 4362.5 3 12 9 3 6 9
THE ZEROS IN PARENTHESES (0.0) INDICATE THE NOTE: FOR RECORD DRAWING PREPARATION - CIRCLE END |2 ALLOWABLE END TREATMENT OPTIONS ARE INDICATED WITH
DIMENSIONAL PRECISION FOR THAT COLUMN. TREATMENT INSTALLED. THE NUMBER "1' IN THE SPACE. BLANK SPACES ARE NOT
VIABLE ALTERNATIVES.
@ LENGTH IS FROM LENGTH OF NEED (LON) POINT TO LON SEE BRIDGE SHEETS FOR BRIDGE BARRIER DETAILS AND
POINT. ACTUAL SEGMENT LENGTH VARIES DEPENDING QUANTITIES. B ARRAY TYPE AND ANGLE IS NOTED UNDER 'REMARKS'.
ON TERMINAL TYPE. SEE SPECIAL PROVISIONS.
NAME DATE |  ARIZONA DEPARTMENT OF TRANSPORTATION staTE | PROJ DNo._ | SHEET | TOTAL [ ot coRrD DRAWING
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dta - Detail Sheet A

Seed File=Z:\Root Workspace Location\Configuration\Organization-Civi\ADOT Corporate Standards\Seed\Rdwy modelseed.dgn

Set Active>Sheet Model Drawing Scale 1:1

Raster Manager
File>Attach>Raster>x1971.pdf
Interactive>Yes
Level: Draft Plan Label
pick the two corners of the Sheet Model

For use of this Detail X197l.dgn, see Design Memo at http://www.azdot.gov/

highways/RdwyEng/RoadwayDesign/design_memos/Index.asp
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Dates
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appropriate for use of this drawing. Contents within the inner border shall

The information presented in this Roadway Plans Detail is for general use.
Designers should satisfy themselves that their project site conditions are
not be altered, except for the addition of the Detail designation.
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(See General Note 2)
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L be required If spacing exceeds 30" on larger end sections.

3. Safety and longltudinal bars are not required on 30" and smaller
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- - A - Headwalls Are Normally Required for Pipe Sizes 48" and Larger
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appropriate for use of this drawing. Contents within the inner border shall

The information presented in this Roadway Plans Detail is for general use.
Designers should satisfy themselves that their project site conditions are
not be altered, except for the addition of the Detail designation.

For use of this Detail X197l.dgn, see Design Memo at http://www.azdot.gov/
Note to Designer:
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A longitudinal bar is required for cross-drainage end sections when
the span (W) is greater than 30". Additional longitudinal bars shall
be required if spacing exceeds 30" on larger end sections.

Safety and longitudinal bars are not required on 30" and smaller
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cs1 - Survey Control Sheet

Seed File=Z:\Root Workspace Location\Configuration\Organization-CivilNADOT Corporate Standards\Seed\Rdwy modelseed.dgn

Set Active>Sheet Model Drawing Scale1:1

Attach Reference file: Border into the Sheet Model 1:1
Place Active Cell

Attach File: Z:\Root Workspace Location\Configuration\WorkSpaces\ADO T\WorkSets\dev\dgn\Plans\sheets.cel

Highlight GNO1

right-click Place Cell

X Scale: 1.0

Y Scale: 1.0

Drop Element>Complex

delete all but GENERAL NOTES

Open LS1283 I-40 Report.txt

Copy
Project Name: LS1283

Description: I-40 A1 MTN TI

BASIS OF BEARINGS:
ADOT Engineering Survey Crew surveyed and provided the Coordinates for the
project. Coordinates were based on NAD83\92 Horizontal and NAVD88 Vertical Datum
with a GAF of 1.00045. NGS Control Points used for this project include: FLAGSTAFF NCMN RM 3,
C504, PORTAL AZ MK, L490, and DOT.

BASIS OF ALIGNMENT AND STATIONS:

Best Fit Alignments were based on split of existing edge of pavement survey
points and R\W Markers located in the field. The alignments were tied to Station: POB 2136+51.81
(POT 3802A I-40EB), POB 2136+87.27(POT 3802A I-40WB), POB 7280+00.0 (POT 3787 I-17NB), and
POB 7285+00.0 (POT 3787 I-17SB). 3802A were tied to Station: POT 1579+41 |-40EB and POT 1567+33.01
I-40WB.

Record Drawings 40-3(22), ACNH-40-3(71), ACNH-40-3(87)A, and IM-40-3(78), were used to construct
the alignment file.

BASIS OF ELEVATIONS:
NGS Monument Stamped PORTAL AZ MK with elevation 7000.968, was held as basis of elevation for
the project.

Place Text>Paste

Open LS1283 CONTROL ADJUSTED GROUND.xls

1. Select the Area in the Excel file to be placed in MicroStation

2. Copy

3. In MicroStation, Right click in the View for the pop-up menu

4. Select>Paste from Clipboard

5. Select>Paste as: Embedded

Select>Method: By Size

Extended Setting>Select>Transparent Background and Rotate With View
6. Pick where to Paste

scale:1.00

Table Formatting, see P-STD 08

Print Monochrome

GENERAL NOTES

Project Name: LS1283
Description: I-40 A1 MTN TI

BASIS OF BEARINGS:
ADOT Engineering Survey Crew surveyed and provided the Coordinates for the
project. Coordinates were based on NAD83\92 Horizontal and NAVD88 Vertical Datum
with a GAF of 1.00045. NGS Control Points used for this project include: FLAGSTAFF NCMN RM 3,
C504, PORTAL AZ MK, L490, and DOT.

BASIS OF ALIGNMENT AND STATIONS:

Best Fit Alignments were based on split of existing edge of pavement survey
points and R\W Markers located in the field. The alignments were tied to Station: POB 2136+51.81
(POT 3802A I-40EB), POB 2136+87.27(POT 3802A I-40WB), POB 7280+00.0 (POT 3787 I-17NB), and
POB 7285+00.0 (POT 3787 I-17SB). 3802A were tied to Station: POT 1579+41 [-40EB and POT 1567+33.01
I-40WB.

Record Drawings 40-3(22), ACNH-40-3(71), ACNH-40-3(87)A, and IM-40-3(78), were used to construct
the alignment file.

BASIS OF ELEVATIONS:
NGS Monument Stamped PORTAL AZ MK with elevation 7000.968, was held as basis of elevation for
the project.

FINAL GRID COORDINATES CENTRAL ZONE

1-40 A-1 MOUNTAIN

LS1283 F010701D

CONTROL FROM P&M3894

VALUES OBTAINED BY ESS

DATA COLLECTED BY ESS Legend:
INTERNATIONAL FEET NGS Control in the Area

NAD83/92 HORIZONTAL & NAVD88 VERTICAL [ESSSETCONTROL

GRID ADJUSTMENT FACTOR = 1.00045

NAME GRID (N) | GRID (E) |ELEVATION DESCRIPTION
PRIMARY
FLAGSTAFF NCMN RM 3 | 1534319.838 | 784485.845 7111.312  |[NGS CONTROL
C 504 1532066.498 | 819840.961 6668.258  |NGS CONTROL
PORTAL AZ MK 1510192.752 | 770235.174 7000.968  |[NGS CONTROL _ |BASIS OF ELEVATION
L 490 1539606.737 | 731255.403 7128.524  |[NGS CONTROL
DOT 1538275.476 | 733559.799 7131.923  |[NGS CONTROL
SECONDARY
PORTAL CHK ESS SET
TRAV1 ESS SET
TRAV2 ESS SET
TRAV3 ESS SET

P-STD 07



FINAL GRID COORDINATES CENTRAL ZONE GENERAL NOTES
1-40 A-1 MOUNTAIN
LS1283 F010701D

Project N :L.S1283
CONTROL FROM P&M3894 Boéigript?$?I-4OA1 MTN TI
VALUES OBTAINED BY ESS EASIS OF BEARINGS.
DATA COLLECTED BY ESS Legend: ADOT Engineer/:ng Survey Crew surveyed and provided the Coordinates for the
INTERNATIONAL FEET NGS Control in the Area project. Coordinates were based on NAD83\92 Horizontal and NAVD88 Vertical Datum
NAD83/92 HORIZONTAL & NAVDSS VERTICAL [ESSISET.CONTROL Il O A 00D NS Contct ol o o this pec alad: FLAGSTAPF NGMN FM 3

GRID ADJUSTMENT FACTOR = 1.00045 BASIS OF ALIGNMENT AND STATIONS:

Best Fit Alignments were based on split of existing edge of pavement survey

points and R\W Markers located in the field. The alignments were tied to Station: POB 2136+51.81
NAME GRID (N) | GRID (E) |ELEVATION DESCRIPTION (POT 3802A I-40EB), POB 2136+87.27(POT 3802A I-40WB), POB 7280+00.0 (POT 3787 I-17NB), and
PRIMARY POB 7285+00.0 (POT 3787 I-17SB). 3802A were tied to Station: POT 1579+41 I-40EB and POT 1567+33.01
FLAGSTAFF NCMN RM 3 | 1534319.838 | 784485.845 7111.312  |[NGS CONTROL I-40WB.
C 504 SEEUEEAEE | SR Oy EEE-E 1 NGS CONTROL Record Drawings 40-3(22), ACNH-40-3(71), ACNH-40-3(87)A, and IM-40-3(78), were used to construct
PORTAL AZ MK 1510192.752 | 770235.174 7000.968 |NGS CONTROL  |BASIS OF ELEVATION the alignment file.
L 490 1539606.737 | 731255.403 7128.524  |NGS CONTROL
DOT 1538275.476 | 733559.799 7131.923 |NGS CONTROL BASIS OF ELEVATIONS:
the project.
PORTAL CHK ESS SET
TRAV1 ESS SET
TRAV2 ESS SET
TRAV3 ESS SET

NAME DATE ARIZONA DEPARTMENT OF TRANSPORTATION STATE PROJECT NO. FEDERAL IDNO. | SHEET [ TOTAL | prcoORD DRAWING
DESIGN INFRASTRUCTURE DELIVERY AND OPERATIONS DIVISION E H.W.A. Arizona Division NO. |SHEETS
DRAWN ROADWAY DESIGN SECTION ARIZ.| 040 CN 190 040-C(224)T
CHECKED ROUTE LOCATION
TEAM LEADER [-40 A-1 MOUNTAIN TI UP STR. NO. 896
MADOT
SHEET OF TRACS NO. F0107 01C Infrastructure Delivery and Operations - OF_

SECONDARY . NGS Monument Stamped PORTAL AZ MK with elevation 7000.968, was held as basis of elevation for



g01 - Geometry Sheet

Seed File=Z:\Root Workspace Location\Configuration\Organization-CivilADOT Corporate Standards\Seed\Rdwy modelseed.dgn

Set Active>Sheet Model Drawing Scale 1:1
Level=Draft Plan Labels

BEFORE FORMATTING

Horizontal Elements Table Report

Report Created: Tuesday, April 17, 2018

Project: Default
Description:
Z:\Root Workspace

Time: 5:57:03 AM

File Name: Location\Configuration\WorkSpaces\ADOT\WorkSets

\dev\dgn\3D\Mainline_Corridor.dgn
Last Revised: 4/17/2018 5.56
Note: All units in this report are in feet unless
specified otherwise.

Point Point Delta / | Rotation
Element Type Number| Station Northing Easting | Radius | Length | Theta |Direction K P
Aligment Name: 100
Description:
Style: Alignment\Geom_Baseline
Tangent POB 1892+00.00| 1528296.31| 750653.68
Tangent PC 1895+02.19| 1528261.98| 750953.92

Horizontal Elements Table Report

Report Created: Tuesday, April 17, 2018
Time: 5:57:03 AM

Project: Default
Description:

Z:\Root Workspace
Location\Configuration’\WorkSpaces\A
Last
Revised: 4/17/2018 5:56
Note: All units in this
report are in feet
unless specified

File Name:

otherwise.
Point Point Delta/ | Rotation

Element Type Number Station Northing Easting | Radius | Length Theta Direction P
Aligment Name: 100
Description:
Style: Alignment\Geom_Baseline

Tangent POB 1892+00.00 | 1528296.31 | 750653.68

Tangent PC 1895+02.19 | 1528261.98 | 750953.92

EXCEL IMPORTS
GENERAL NOTES

1. Select the Area in the Excel file to be placed in MicroStation

2. Copy

3. In MicroStation, Right click in the View for the pop-up menu

4. Select>Paste from Clipboard

5. Select>Paste as: Embedded

Select>Method: By Size

Extended Settings Select>Transparent Background and Rotate With View
6. Pick where to Paste

General Formatting for the Excel file
All Text should be Arial

Title Text should be 24 Bold

New Text should be 18 Italic
Existing Text should be 14

Existing Text ~ New Text Title Text

012 .015 .020 MicroStation Text
10 11 12 14 16 18 20 22 24 Excel Text

P-STD 08



Horizontal Elements Table Report i
Report Created: Tuesday, April 17, 2018
Time: 5:57:03 AM
Project: Default
Description:
File Name: Z:\Root Workspace
| Last Revised: 4/17/2018 5:56
i Note: All units in this 5
report are in feet
unless specified ;
Point Point Delta/ | Rotation
Element Type Number Station Northing Easting | Radius | Length | Theta |Direction K P |
Aligment Name: 100 ;
Description:
Style: Alignment\Geom_Baseline
Tangent POB 1892+00.00| 1528296.31| 750653.68
Tangent PC 1895+02.19| 1528261.98| 750953.92
Arc PC 1895+02.19| 1528261.98| 750953.92
Arc PI 1908+86.28 | 1528104.76 | 752329.05| 4583.66 | 2688.37| 33.605°| Right
i Arc cC 1523707.99 | 750433.25 5
Arc PT 1921+90.56 | 1527212.73 | 753387.35
Tangent PT 1921+90.56 | 1527212.73 | 753387.35
Tangent TS 1926+17.43| 1526937.62 | 753713.74 |
Clothoid TS 1926+17.43| 1526937.62 | 753713.74
Clothoid SPI 1928+17.46 | 1526808.71| 753866.69 300 3°| Left 149.99 | 1.31
Clothoid SC 1929+17.43| 1526748.33 | 753946.44
i Arc SC 1929+17.43 | 1526748.33| 753946.44
| Arc PI 1932+54.84 | 15626544.68 | 754215.46 | 2864.79 | 671.72| 13.434° Left
i Arc cC 1529032.42 | 755675.58 ;
i Arc CS 1935+89.16| 1526409.1| 754524.43 ;
i Clothoid CS 1935+89.16| 1526409.1| 754524.43
Clothoid SPI 1936+89.18| 1526368.9| 754616.02 300 3°| Left 149.99 | 1.31
Clothoid ST 1938+89.16 | 1526298.22 | 754803.15
Tangent ST 1938+89.16 | 1526298.22 | 754803.15
Back Station 1938+89.16 | 1526298.22 | 754803.15 |
Ahead Station a 1939+27.16
Tangent POE a 2034+00.00| 1522950.95| 763664.89
E NAME DATE ARIZONA DEPARTMENT OF TRANSPORTATION STATE PROJECT NO. FEDERAL D NO. [ SHEET | TOTAL | recoRD DRAWING i
DESIGN INFRASTRUCTURE DELIVERY AND OPERATIONS DIVISION F.H.W.A. Arizona Division NO. |SHEETS |
: DRAWN ROADWAY DESIGN SECTION ARIZ.| 040 CN 190 | 040-C(224)T |
I CHECKED ROUTE LOCATION :
TEAM LEADER 1-40 A-1 MOUNTAIN Tl UP STR. NO. 896 |
SHEET o TRACS NO.  F0107 01C ﬁePIopt _ OF__
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